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BÀI 28 NGÀY 5.4.2010 UTBINH SOẠN THEO KS NGUYỄN MINH ĐỨC  
 

I.FORMAT PAINTER 
Là một công cụ đơn giản giúp bạn có thể sao chép tất cả cài đặt định dạng của Ô bao 
gồm : Font , màu sắc , vùng tô , đường viền và thậm chí định dạng số từ 1 Ô này sang 1 

Ô khác . 
Cách thực hiện như sau : 

1. Chọn Ô ( hoặc toàn bộ nhóm Ô ) có định dạng mà bạn muốn sao chép . Bạn có thể 

sao chép từ 2 Ô có 2 màu khác nhau và dán định dạng đó vào toàn bộ dãy Ô mới . 
Những Ô này được xen kẻ giữa màu tô .  

2. Chọn Home > Clipboard > Format Painter  để chuyển sang chế độ “ formatting  
painter “ ( Tô định dạng ) . Con trỏ đã biến thành cái cọ . 

3. Nhấp vào Ô , nơi mà bạn muốn nó áp dụng định dạng > Bạn nhả chuột > Chuột 
trở lại diện mạo ban đầu . Nếu bạn muốn sao chép định dạng đã được chọn đến 
nhiều Ô cùng một lúc , chỉ cần rê để chọn một nhóm Ô các hàng , hoặc cột thay vì 

nhấp một Ô  
4. Excel không cho phép bạn áp dụng lần thứ 2 vào 1 Ô khác . Nếu bạn muốn thì 

phải trở lại bước đầu . Có một cách áp dũng nhiều lần : Đó là thay vì nhấp 1 cái 
vào Nút Format Painter , bạn nhấp đúp lên nó và bạn sẽ được áp dụng nhiều lần 

vào các Ô khác . 
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5. Format Painter là 1 công cụ tốt cho việc sao chép định dạng một cách nhanh 
chóng nhưng nó không phù hợp với những đặc tính khác của Excel được gọi là 

STYLE ( Kiểu ) . Với Style bạn có thể chỉ ra một nhóm các cài đặt định dạng và sau 
đó áp dụng chúng bất kỳ chổ nào mà bạn muốn . Nếu bạn thay đổi kiểu sau khi 

bạn đã tạo ra nó , Excel tự động cập nhật tất cả các Ô mà bạn vừa định dạng bằng 
cách sử dụng kiểu đó . 

 

II.TẠO DẠNG THỨC SỐ  
 

Trong Excel có rất nhiều dạng thức biểu diễn dữ liệu , ngoài dạng thức phổ biến cho 

hầu khắp các quốc gia còn có những dạng thức do từng quốc gia qui định , trong 
đó có những dạng thức như ( Soạn theo KS NGUYỄN ĐÌNH TÊ ) : 

 

1. DẠNG SỐ ( NUMBER ) : 
 

 Theo mặc định phân cách giữa Số Nguyên và Số Lẻ ( Số Thập Phân ) là 

dấu chấm (.) ví dụ : 45.2 - 1236.55 , phân cách số ngàn là dấu phẩy (,) ví 
dụ : 123,456,568 . Tuy nhiên bạn có thể thay  đổi theo cách của Việt Nam 
[ Số lẻ là dấu phẩy ( ví dụ : 2345,23 - 1258,16 ) , số hàng ngàn là dấu 

chấm ( 23.456 – 2.235.459 – 1.256.354.265 ) bằng cách trở về Windows  
o Nhấp Start > Control Panel > Nhấp đúp lên Regional and Language 

Options để mở HT này > Chọn Thẻ Regional Options > Nhấp 
Customize để mở HT Customize Regional Options > Chọn Thẻ Number  

 

 
 

 
 

 
 
 

 
 

  
 

 
 
 

 
 

 
 

 
 
 

 
 

 Trong Decimal symbol thay dấu chấm bằng dấu phẩy > Trong Digit 
grouping symbol thay dấu phẩy bằng dấu chấm > Apply > Ok . 
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 Kể từ bây giờ , bạn nhập theo kiểu Việt Nam mà bạn đã dùng ghi số Ví 

dụ : Số chẳn 1.320.456 – 5.689.231.256 - Số lẻ : 23,45 – 456,456 
 

2. DẠNG NGÀY ( DATE ) : 
 

 Cách thể hiện dữ liệu dạng ngày cũng ttùy thuộc vào từng quốc gia : 

 Nhấp Ctrl+1 để mở HT Format Cells > Nhấp Thẻ Number > Trong 

Vùng Category chọn Date > Trong Local ( Location) chọn Vietnamese  
> Trong Vùng Type nhấp vào 1 dạng muốn thể hiện  

 
  

 
 
 

 
 

 
 

 
 
 

 
 

 
 
 

 

3. DẠNG GIỜ ( TIME ) : 
 

 Thao tác tương tự như trên bạn có thể chọn dạng thức biểu diễn dữ 

liệu dạng GIỜ của Việt Nam . Ví dụ để biểu diễn thời gian là : 1 giờ 30 
chiều , bạn có thể sử dụng 1 trong 4 cách : 
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4. DẠNG TÙY BIẾN ( CUSTOMIZE ) : 
 

 Excel cho phép người dùng sử dụng dạng thức dữ liệu tùy biến để biểu 

diễn dữ liệu được đa dạng .  
 Trong Category nhấp Custom > Trong Vùng Time bạn chọn 1 dạng 

thức , dạng thức đó sẽ thể hiện trong Type . 

 
 
 

 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

 
 

 

 

III.TẠO MACRO ĐỊNH DẠNG SỐ   
 

1. TẠO MACRO :  
Bạn có thể tạo một số lệnh , một số thao tác . . . rồi gán cho 1 phím , một nút 
dụng cụ nào đó gọi là Macro . Muốn tạo Macro bằng cách ghi từng bước thực 

hiện một số tác vụ nào đó .  
Ví dụ : Nhập chuổi ngày , tháng , năm hoặc định dạng số , định dạng Bảng Tính 

rồi gán tất cả các thao tác này cho 1 Phím . Khi sử dụng lại các thao tác đó , 
người dùng chỉ cần bấm vào Phím đó , Excel sẽ lần lượt thực hiện các tác vụ đã 
quy định  

 
 TẠO MACRO ĐỊNH DẠNG SỐ : 

 
 Mở Bảng Tính > Chọn 1 Ô , 1 Vùng hoặc 1 Cột dữ liệu  > Thẻ View  > 

Nhấp xổ xuống của Macro > Chọn Record New Macro để hiển thị HT 

Record Macro . 
 Record name gỏ tên ( Không đứt khoảng ) > Shortcut key gỏ vào 1 

Phím gán cho Macro để sau này khi cần thực hiện thì bạn chỉ cần bấm 
Phím Ctrl và Ký Tự của Phím đó .Bạn cũng có thể bấm giữ Phím Shift 

và Gỏ Ký tự để tạo Tổ Hiợp Phím : Ctrl+Shift+ Ký Tự . 
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 Store Macro in : Nhấp xổ xuống chọn 1 trong 3 phạm vi ứng dụng : 

o This WorkBook : Ứng dụng macro cho Bảng Tính hiện hành . 
o New WorkBook : tạo và ứng dụng cho bảng Tính mới . 

o Personal Macro WorkBook  : Ứng dụng Macro cá nhân cho Bảng 
Tính này . 

 Decription : Mô tả ngắn gọn đặc điểm của Macro . Ok để bắt đầu ghi 

tùng Phim và Lệnh . Không ghi nửa nhấp Macro chọn  Stop Recording 

. 
  
 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

 Khi tạo Macro dạng số , bạn cần phải thực hiện bổ sung : Ctrl+1 để 
mở HT Format Cells > Category chọn Number > Decimal places chọn 

3 > Đánh dấu chọn Use 1000 Separartor > Chọn dạng số âm theo 
hình > Ok > Nhấp Stop Recording để chấm dứt ghi . 
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 Sau khi tạo Macro , bạn muốn sử dụng chổ nào ,nhấp chuột vào chổ 

ấy rồi bấm Tổ Hợp Phím đã gán cho Macro . 
 Nếu ở một vị trí nào đó không thi hành được Macro sẽ xuất hiện thông 

báo lỗi > Nếu biết lập trình Visual Basic , bạn nhấp nút Deburg hoặc 
Tools Macro > Visual Basic Editor hoặc Alt+F11 mở cửa sổ mã nguồn 

để bạn chỉnh sữa . 
 Nút Macro có 3 tùy chọn : 

Sau khi tạo mcro xong , bạn nhấp View Macros sẽ hiện ra Bảng Macro  
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IV.TẠO ĐỊNH DẠNG TRONG STYLE 
 

Trong Excel có một số định dạng chuẩn như NORMAL ( Định dạng tổng quát ) , COMMA 
, COMMA [0] ( Dấu phẩy ) , CURRENCY , CURRENCY[0] ( Tiền tệ ) và PERCENT (Phần 

trăm) cho dữ liệu kiểu NUMBER ( Số )  . Nếu thấy cần thiết cho công việc của mình , 
bạn có thể tạo 1 Style mang tính đặc thù và đặt tên cho nó để sử dụng .  

 

CÁC STYLES ( KIỂU ) : 
 Ví dụ : bạn tạo 1 Style tên utbinh_1 bằng cách sử dụng : Font Tahoma – Size 12 

point – Tô màu Đỏ nhạt . Cho phép các bạn tạo 1 tập hợp các cài đặt định dạng 

được tùy biến , đặt tên cho tập hợp đó và lưu nó trong 1 File Trang Bảng Tính . 
Sau đó bạn có thể áp dụng các cài đặt này ở bất cứ nơi nào mà bạn cần .  

 Mỗi Trang Bảng Tính Excel được bắt đầu với 1 bộ sưu tập Style đã được xây dựng 
trước . Microsoft thiết kế các Styles này với 2 mục đích : Để bạn truy cập nhanh 

chóng đến một định dạng hữu ích và phổ biến nhất - tạo ra những tài liệu trông 
đẹp mắt .  

 Mở Excel > Chọn 1 Ô > Bạn vào : Thẻ Home > Styles > Cell Styles > Khi đặt con 
trỏ lên 1 Style , lập tức ô đó sẽ được thay đổi phản ảnh Style đó . Để áp dụng Style 

bạn hãy nhấp lên nó .  
 

 
 
 

 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
 

 
 

 Mô tả Cell Styles và công dụng từng Hạng Mục :  

 

o Good Bad and Neutral : Cho phép bạn chọn chúng để đánh dấu phân loại 
những tin tức Tốt - những tin tức xấu bằng cách chọn màu phổ biến như đỏ 
vàng , xanh lá cây . 

o Titles and Heading : Bổ sung định dạng đường viền để tạo những Tiêu đề 
hấp dẫn . 
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o Themed Cell Styles : Cho bạn 1 dảy Ô được làm bóng , tô màu khác nhau để 
làm hài hòa với các Ô khác dựa vào chủ đề cửa sổ bảng Tính hiện hành . 

o Number Format : Đây là những Style duy nhất mà Excel có trong những 
phiên bản trước dùng áp dụng 1 định dạng số khác nhau như : Currency – 

Percent . Chúng không thay đổi các diện mạo . Bạn có thể sử dụng kiểu 
Currency cho tất cả giá trị Đô La trong Bảng Tính của bạn .Sau đó tại 1 điểm 

bạn có thể bổ sung kiểu đó để xác lập những ký hiệu tiền tệ khác nhau , sự 
canh thẳng hoặc số các chữ số thập phân . Sự thay đổi này cập nhật mỗi Ô 
mà nó sử dụng kiểu Currency . 

 
 Bổ sung Style Gallery vào Thanh Công Cụ Quick Access  :  

 
o Nhấp Thẻ Home > Styles > Cell Styles > Nhấp Phải vào bất kỳ Style nào >  

Chọn Add Gallery  To Quick Access , nơi mà nó có sẵn trong mọi lúc  . Nhấp 
vào Nút này bạn sẽ thấy Style Gallery  tương tự . Bạn cũng có thể bỏ nó 

bằng cách nhấp Phải nó > Chọn remove From Quick Access Toolbar . 
 

TẠO STYLES : 
 
Bạn thực hiện như sau : 

1. Đến 1 Ô trống chưa được định dạng trong Bảng Tính của bạn . 
2. Chọn Home > Styles > Cell Styles > New Cell Style > HT Style , Style name nhập 

tên (utbinh_1). Khi lập Style , bạn chỉ muốn lập : Number , Font và màu nền 
(Fill) có thể xóa dấu kiểm Aligment ,Border nếu muốn các chi tiết này không đưa 

vào Style sắp tạo > Ok .  
 

 
 
 

 
 

 
 
 

 
 

 
 

 
 
 

 
 

 
 

 
3. Bạn tiến hành chọn các định dạng trong Number – Font và Fill . Khi chọn xong 

bấm Ok để tạo riêng cho bạn 1 Style . 

4. Khi tạo xong , nó xuất hiện trong Nhóm Custom ( Nếu chưa tạo Style nào thì bạn 
sẽ không thấy Nhóm Custom ) .  
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I.TẠO STYLE : 

 
 Nhấp Thẻ Home > Format > Format Cells  

 

 
 
 

 
 

 
 

 Lựa chọn các thuộc tính định dạng cho Style của bạn bằng cách Click chuột vào 
các Thẻ : 

o Number : Chọn loại định dạng số như đã trình bày ở trên . 

 

 
 
 

 
 

 
 

 
 
 

 
 

 
 

 
 

o Alignment : Đóng lề văn bản trong Ô bảng Tính có các loại như : 

 Text Alignment , dóng lề văn bản dữ liệu , chọn  : 
o Horizontal ( Theo chiều ngang ) : Thông thường Excel chọn 

General , theo loại này văn bản dóng thẳng lề bên Trái , dữ liệu 
số dóng thẳng lề bên Phải , dữ liệu luận ký ( Logical ) xếp vào 

giữa Ô .  
o Left ( Indent ) : Dữ liệu dóng thẳng lề Trái . 
o Right ( Indent ) : Dữ liệu văn bản dóng thẳng lề Phải . 

o Center : Toàn bộ dữ liệu canh hàng vào giữa Ô . 
o Justify : canh thẳng lề Trái Lề Phải . 

o Fill : Điền đầy đủ dữ liệu . 
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o Center Across Selection : Canh giữa ngang qua vùng lựa . 
 

 
 

   
 

 
 
 

 
 

 
 
 

 
 

 
 Vertical ( Theo chiều dọc ) : 

o Bottom : Sát đáy Ô . 
o Top : lên đỉnh Ô . 

o Center : Vào giữa Ô . 
 

 
 
 

 
 

 
 

 Text Control  ( Kiểm soát văn bản ) : 
 
 

 
 

 
 
 

 
 

 
 

 
o Merge Cells : Trộn các Ô . 
o Wrap Text : Nới rộng văn bản . 

o Shrink to Fit : Vừa khít chiều rộng dữ liệu . 
 

 Orientation ( Hướng của văn bản ) : 
Bạn có thể Click vào các nút ( Mỗi nút 15 độ ) hoặc gỏ vào hộp 

Degrees . 
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o Font : Lựa chọn Font , kiểu , kích thước , màu và các hiệu ứng . 

 Font : Rê thanh trượt để chọn Font chữ . 
 Font Style ( Kiểu chữ ) : Mội Font chữ có thể có các kiểu chữ riêng , 

hãy rê Thanh trượt để tìm kiểu chữ thích hợp . 
 Size ( kích thước hay cở chữ ) : Tùy thuộc và Font và khả năng của 

máy in , bạn có thể chọn từ 1 đến 1638 hoặc rê thanh trượt để lựa 
kích thước Font và kiểu chữ đã chọn . 

 Underline ( gạch dưới ) : Nhấp xổ xuống để tùy chọn . 

 Color ( Màu chữ ) : Nhấp xổ xuống chọn màu chữ > Nhấp More Colors 
để chọn thêm Bảng màu . 

 Effects ( các hiệu ứng ) : Chọn 1 trong 3 hiệu ứng sau : 
o Strikethrought : Gạch giữa chữ . 

o SuperScript : Tạo chỉ số trên như X2 
o SupScript : Tạo chỉ số dưới như Fe3O4. 
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o Border  ( Khung viền ) :  
 Style : Chọn 1 kiểu đường viền . 
 Preset : Chọn 1 mẫu có sẵn ( None : Không tạo Khung viền – Outline : 

Tạo khung viền bên ngoài – Inside : tạo các đường kẻ ngang và dọc 

bên trong Khung ) . 
 Border : Tạo viền cho từng cạnh khung  

 Color : Chọn màu cho đường viền . 
 

 
 
 

 
 

 
   
 

 
 

 
 

 
 
 

 
 

 
 

 

o  Fill  ( Đổ màu nền ) :  
 Background Color ; Chọn màu nền . 
 Pattren Color : Các mẫu Pattern  
 Pattern Style : Các kiểu Pattern . 

 Fill Effects : Hiệu ứng đổ màu . 
 More Colors : Chọn thêm màu . 
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o  PROTECTION  ( Bảo vệ ) :  
Có 2 chọn lựa : Locked và Hidden . 
 
 

 
 

 
 

 
   
 

 
 

 
 
 

 
 

 
 

 
 
 

 
Sau khi hoàn tất lựa chọn các thuộc tính trong các Thẻ , Click nút OK để trở về .  

 Nhấp Thẻ Home > Nhóm Style , nhấp xổ xuống của Cell Style > Chọn New Cell 
Style > Ra HT Style , Đặt tên cho Style mới vừa tạo ( utbinh1 ) và dưới đó tóm tắt 

các lựa chọn > Ok . 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
 

 
 
 

 

II.ÁP DỤNG STYLE : 
    Sau khi đã tạo Style , muốn sử dụng nó , bạn thực hiện :  

1. Khởi động Excel > Mở bảng Tính cũ > Chọn vùng dữ liệu cần áp dụng Style . 
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2. Chọn Format > Style > Cell Style > Chọn tên Style mà bạn vừa tạo > Ok . 
 

 
 

 
 

 
 
 

 
 

 
 

III. ÍCH LỢI CHO VIỆC TẠO STYLE : 
 

1. Chúng cho phép bạn sử dụng lại Định Dạng của mình một cách dễ dàng chỉ bằng 

cách áp dụng Kiểu . 
2. Chúng có tính thống nhất bởi vì các Kiểu chứa tất cả các định dạng mà bạn muốn 

( đã tạo ) . 
3. Excel tự động lưu các kiểu với File Trang bảng Tính của bạn . Bạn có thể chuyển 

Các Kiểu từ Sổ bảng Tính này sang Sổ bảng Tính Khác . 
4. Nếu bạn muốn thay đổi 1 Kiểu , bạn chỉ cần vài cú nhấp chuột, sau đó Excel tự 

động điều chỉnh mỗi Ô mà sử dụng các Kiểu bổ sung . 

 

IV. CHỈNH SỬA – SAO CHÉP CÁC STYLE : 
 
Sau khi áp dụng 1 Style , bạn có thể chỉnh sửa định dạng 1 Ô . Nếu bạn thấy rằng mình 

đã quá lạm dụng Style và thấy rằng các Style này luôn luôn đúng vì vậy hãy tạo nhiều 
phiên bản của cùng 1 Style , mỗi Style và các cài đặt tương ứng , hoặc xóa một số Ô 
kiểm của Style để Style của bạn không áp dụng các cài đặt định dạng mà bạn thường 

xuyên thay đổi . 
 

1. CHỈNH SỦA  : Vào Home > Styles > Cell Styles  . Tìm Style mà bạn muốn thay đổi 
đang trong Gallery , nhấp Phải nó > Chọn Modify > Áp dụng giống như lúc tạo để 

sửa . 
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2. SAO CHÉP : Thực hiện các bước giống trên thay vì chọn Modify bạn chọn 

Duplicate > Thay đổi định dạng như mong muốn > Chọn tên khác để bổ sung vào 
Hạng mục Custom . 

3. XÓA : Chọn Delete .  
 

 

V. CHUYỂN ĐỔI CÁC STYLES GIỮA  CÁC SỔ BẢNG TÍNH : 
 
Khi bạn đã tạo ra một vài Styles hữu ích , bạn muốn sử dụng chúng trong những File 
của Trang Bảng Tính khác nhau . Để sử dụng chúng , bạn cần sao chép thông tin Style  

từ một Sổ bảng Tính này đến một Sổ Bảng Tính khác . Excel thực hiện quá trình này khá 
dễ dàng . 

 
1. Mở cà 2 File của Bảng Tính Nguồn ( Có chứa các Style mà bạn muốn sao chép ) và 

bảng Tính Đích . 

2. Đến Sổ bảng Tính Đích > Chọn Home > Styles > Cell Styles > Merge Styles > HT 
Merge Styles xuất hiện với một danh sách của tất cả các Files mà bạn đã mở gần 

đây trong Excel . 
3. Chọn File mà trong đó có Style mà bạn muốn sao chép vào Sổ Bảng Tính hiện 

hành > Ok . 
 Nếu có Style nào mà trùng tên vớii Style hiện hành , nó ra một thông điệp 

cảnh báo bạn . Nếu muốn áp dụng , nó sẽ chép đề lên khi bạn nhấp Ok . 
 Bạn có thể sử dụng các Style mà bạn vừa nhập . Bây giờ những Styles này là 

những bản sao chép độc lập của các Styles trong Sổ bảng Tính Nguồn . Nếu 
bạn thay đổi Styles trong 1 Sổ Bảng Tính , sẽ không ảnh hưởng đến các 

Styles trong Sổ Bảng Tính kia trừ khi bạn nhập các Style được thay đổi vào 
nó . 

 Thủ Thuật : Nếu bạn muốn thêm vào một cách tự động các Styles của bạn 
vảo trong một số Bảng Tính Mới , hãy tạo ra 1 Mẫu chứa các Styles này .Các 

có thể tạo ra các Sổ Bảng Tính Mới dựa vào mẫu đó . 
 

VI.TẮT CHẾ ĐỘ XEM TRƯỚC : 
 
Chế độ XEM TRƯỚC rất hữu ích .Tuy nhiên nếu bạn đang sử dụng một số Bảng Tính 
được định dạng , bạn sẽ thấy tính năng xem trước bị giảm tốc độ khi bạn muốn cuộn 
qua nhiều tùy chọn . Trong trường hợp này ,tốt nhất nên tắt chế độ xem trước . 

 Cách tắt chế độ xem trước : Nút Office > Excel Options > Chọn Popular > Hàng 
Top Options  for working with Excel , tắt : Enable Live  Preview  > Ok . Bây giờ 

bạn có thể di chuyển quanh Ribbon . Khi bạn cần thay đổi một định dạng , nhấp 
vào nút tương ứng trên Ribbon trước khi bạn xem nó trông như thế nào . 

 
 


